Personal Page Management Guide
# Contents

**PERSONAL PAGES** ................................................................. 1

**Design and Management Process** ............................................. 1

**Personal Pages: Process Overview** ..................................... 2

- Create Personal Page Elements ........................................... 3
- Create Web Pages ............................................................ 3
- Manage Personal Pages ..................................................... 4
- Design the Personal Page Manager Part ............................. 5
- Add Help Content for Personal Pages ................................. 20
Personal Pages

Design and Management Process

Personal Pages: Process Overview

Personal pages are personalized pages that supporters can set up on your website to share information about themselves and about your organization’s mission. These pages can be used for a variety of purposes. For example, a membership organization can provide personal pages to supporters so they can recruit their family and friends. As another example, a hospital can provide care pages to a patient or a patient’s family to share information about the patient’s status and recovery.

Using the Personal Page Manager part, you create web templates that provide the tools page owners use to create pages. Personal pages can contain several features including blogs, news readers, photo galleries, report abuse actions, comment boards, and simple or rich text.

Design and Management Process

This flow chart illustrates the design and management process for personal pages.
Personal Pages: Process Overview

Creating personal pages requires several steps in different areas of the program:

**Step 1:** The web designer creates Personal Page Elements. For information, see Create Personal Page Elements on page 3.

**Step 2:** The web designer creates web pages containing Personal Page Elements. For more information about creating web pages, see the Website Design Guide.

**Step 3:** The web designer creates the Personal Page Manager part to define the web pages, options, and settings available to personal page owners when they create personalized pages. For more information, see Design the Personal Page Manager Part on page 5.

**Step 4:** The web designer adds the Personal Page Manager part to a page on the website.

**Step 5:** A website user signs up to be a personal page owner. New page owners use the Home page dashboard to create and manage content for personal pages. For information, see Manage Personal Pages on page 4.

**Step 6:** The user downloads personal page requests from the website to the program.

**Step 7:** Website users visit the personal pages to read content, post comments, and give donations.
Create Personal Page Elements

The first step to create personal pages is to create Personal Page Elements. Think of these as “mini-parts” that can be used only on the web page templates you provide to personal page owners. You can create the following element types for personal pages:

- Action
- Comments
- News
- News Reader
- Page Links
- Photos
- Profile
- Rich Text
- Text

For information about creating specific element types, see the *Parts Guide*.

Create Web Pages

The next step is to create the web pages used for personal pages. You will need:

- A web page on your site where you will place the Personal Page Manager part.
- At least one web page that contains Personal Page Elements. These pages are templates that provide the tools page owners use to create their pages. You can create more than one web page template to offer page owners different layouts and features.

Web pages using Personal Page Elements can also contain static sections for other parts. Use these sections for content or features to appear on every personal page. For example, you can create a part for your organization’s mission statement and add it to your web page templates so the mission statement appears on every personal page.

This graphic demonstrates how a web page uses Personal Page Elements with static parts. For more information about creating web pages, see the *Website Design Guide*.
Manage Personal Pages

When you add a Personal Page Manager part to a page on your website, personal page owners can create and manage pages. The Home page dashboard provides a central location for personal page owners to manage their pages.

The action bar on the Home page dashboard allows page owners to navigate between tasks, monitor and update data, edit personal pages, send email, and maintain email contacts.

- **My Home** — To manage their pages, personal page owners click **My Home**. From the My Home page, page owners can click links to design and visit their web pages or to send email. This page also displays statistics about the number of visits a personal page receives, the date of the last visit, the number of email messages a page owner sends, and the number of messages that are opened.

- **My Activity** — To view statistics about email messages, personal page owners click **My Activity**. To view a list of sent email messages, page owners select “Emails” on the action bar of the My Activity page. For each message, details appear about the number of times it was sent, the recipients, and whether it was opened or forwarded. Page owners can sort email messages according to whether they were opened, unopened, forwarded, or delivered unsuccessfully. To view a list of contacts who received email messages, page owners select “People” on the action bar. For each contact, details appear about how many messages were received and whether they opened or forwarded the messages. Page owners can sort contacts according to whether

---

**Note**: If you allow donations from personal pages, we recommend that you create a part or element with a **Donate** button linking to the donation page. For more information, see Step 6: Donation Form (Optional) on page 10.
they have opened or forwarded messages. From the My Activity page, page owners can also click View Email to read the original email messages.

- **My Page(s)** — To preview their pages and change the layout and content, personal page owners click My Page(s). Page owners can select create page templates, create friendly URLs, add pictures, edit text, or adjust settings such as whether to display navigation buttons with a slideshow. If the Personal Page Manager part allows page owners to create multiple personal pages, they can create additional pages from the My Page(s) page. When a page owner has multiple pages, one must be designated as the home page for search results and link to the owner’s personal page. If the Personal Page Manager uses a page with Page Links, the personal page owner must make his pages public for them to appear as links.

- **Send Email** — To generate email messages, personal page owners click Send Email. Page owners can select contacts from the address book or create contacts to add to the address book. After page owners select the contacts, a preview screen displays the names, email addresses, and greetings that will be used. From this screen, page owners can change greetings or click contact names or email addresses to change contact information. Personal page owners select email templates and create the content on the Send Email page.

- **Address Book** — To store email addresses and contact information, personal page owners click Address Book. To add contacts, page owners click New Contact. To use a *.csv file to import email addresses from programs such as Outlook or Eudora, page owners click Import Contacts. When page owners add contacts on the Send Email page, they are saved to the address book. The address book displays up to 10 contacts per page, and the number of contacts and number of pages appear below the grid. The action bar above the grid controls how contacts appear. To display all contacts, click ALL. If there are more than 10 contacts, page owners can use the links below the grid to navigate to additional pages. To view contacts in alphabetic groups, page owners can click the letters on the action bar. Contacts are organized by last name and organization name, which means contacts can appear twice and page owners can search by last name or the organization name. To select a contact, select the checkbox beside the name. To select all contacts on a page, select the checkbox beside the Name column. To select all contacts in the address book, select the checkbox beside the Name column and click the link that appears above the grid. To delete a contact, select it and click Delete on the action bar.

Design the Personal Page Manager Part

The Personal Page Manager part is a series of forms you use to select the web pages, options, and settings available to personal page owners when they create a personal page. After you set up the Personal Page Manager part, you add the part to a page on your website.

- **Step 1: Personal Page Options and Administrator Roles**

  On this screen, you define the options available to users when they create personal pages and decide the roles that have administrative rights over personal pages.

  1. From Site explorer, click Parts. Parts appears.

  2. To edit an existing part, click Edit in the Action column. The Edit Part screen appears displaying the Design tab. The first section is “Step 1: Personal Page Options and Administrator Roles.”

     For information about create or edit a part, as well as the tabs on the Edit Part screen, see the Parts Guide.
3. In the Confirmation Prompt field, enter the message that appears when a website user signs up to create a personal page.

4. In the Constituency field, select the constituency to assign to personal page owners when you download sign-ups. For more information about constituencies, see the Program Basics Guide.

5. You can select Waiver to require site users to agree to a waiver before they can create a personal page. In the box, enter the waiver's text.

6. In the Administrator Roles frame, select the checkbox for each role that needs administrative rights for personal page dashboards. Users with Administrator rights can edit personal page dashboards. To do this, a user with Supervisor rights must send the web page URL link from the user record (in Users) to the Administrator user. The Administrator or Supervisor clicks the link to access the dashboard and make modifications.

   For information about the personal page dashboard, see Manage Personal Pages on page 4. For information about roles and users, see the Users & Security Guide.

- Step 2: User Login Options

On this screen, you set up the user login forms for personal pages.

1. When you configure social media for third-party authentication with social networks such as Facebook and Twitter, Social website login appears with the Enable social website login checkbox. To enable social media options for the login, select the checkbox. Additional options appear.
a. In the Sign in text field, enter the text to display for standard and social network login options.

b. In the Social website sign in text field, enter the text to display above the social site icons.

c. Under Display options, specify where to place the social site icons relative to the standard login fields.

**Note:** For more information about social media for third-party authentication, see the Administration Guide.

2. Under Captions and properties, select whether to include forms for new registrations, forgotten passwords, or forgotten user IDs. To include a form, select its checkbox in the Enabled column.

3. In the Captions and Properties frame, you can define titles for forms that appear when users sign up to create personal pages. The user login form is required, but you can also add forms for new user registrations, forgotten passwords, and forgotten user IDs.
If a user is a member of your website, the site recognizes the user and skips the login page.

a. In the Form Title column, enter titles for the user login, new user registration, forgotten password, or forgotten user ID forms.

b. In the Hyperlink column, enter text for the hyperlinks that direct users to the user login, new user registration, or forgotten password/user ID forms.

c. In the Enabled column, select the types of forms to add to the user login form. You can add forms for new user registrations, forgotten passwords, and forgotten user IDs.

Note: When a user signs up through the login on a Personal Page Manager part type, the user automatically becomes a member of the rest of your website community.

4. In the Constituency field, select the constituency to assign to users who use this registration form to sign up for your website. For more information about constituencies, see the Program Basics Guide.

5. In the Additional Fields frame, select the biographical information fields to include on the new user registration form.

a. In the Additional Fields grid, select the checkbox in the Include column for each field to appear on the form. To make fields required, select the checkboxes in the Required column. When you select Include for the Address block field, it is automatically required.
b. To include attribute fields on your registration form, select the checkbox in the Include column for each attribute field to appear on the form. To make the attributes required, select the checkboxes in the Required column.

6. In the Role Assignment frame, select the checkbox in the Member column for each role to assign to users who sign up through this User Login part. For information about roles, see the Users & Security Guide.

Step 3: Select Pages for use as Personal Pages

On this screen, you make web pages available to personal page owners as templates for their personal pages. You must create at least one web page in Site explorer that contains a Personal Page Element part before you can make selections on this screen. For information about the Personal Page Element part, see Create Personal Page Elements on page 3.

1. In the Page column, select a page from the drop-down list of web pages. Only pages with Personal Page Elements appear in the list. If no pages appear, you must create these in Site explorer.

2. In the Display Name field, enter a descriptive name to help personal page owners select the web page template to use. The display name appears as an option for page owners in the Theme field of the My Page(s) page on the Home page dashboard.

3. To designate a page as the default, select the checkbox in the Default column. Each Personal Page part must have a default page.

4. Click Add Page to add rows to the grid and continue adding web pages.

5. In the Maximum Number of Pages field, select the maximum number of personal pages users can create.

   If you allow users to create more than one page and select a Personal Page Element using Page Links in the Page field, the user’s personal pages appear as a list of links on the page. For more information about Page links, see the Parts Guide.

6. To remove a page from the grid, click Remove.

Step 4: Create Email Designs

On this screen, you create email templates personal page owners can use to send messages about their page.

1. In the Email Designs frame, click Add Email. The new email template screen appears.
2. In the Name field, enter a name for the email template. The program uses the personal page owner’s email address for the From Address field and the owner’s name for the Name field.

3. In the text box at the bottom, use the HTML editor to enter the content of the email. To include personalized information, such as the recipient’s name, click Merge fields on the Insert tab in the toolbar. For more information about the HTML editor, see the Program Basics Guide.

4. Click Save and Close to save the email template and return to the Step 4: Create Email Designs screen. The new email template appears in the grid.

Step 5: Search Page Form Options

1. On this screen, you can define the search form title. Site visitors use the search form to search for a personal page.

2. In the Title field, enter the name for the site search form. If you do not enter a name, “Search for Page Owners” is the default title used.

Step 6: Donation Form (Optional)

On this screen, you can define options for online donations given through personal pages. If you plan to allow donations from personal pages, we recommend that you create a part or element with a Donate button linking to the donation page. After you create a Personal Page Manager part and add it to a web page, a web page named “[Personal Page Manager] PPM — Donate” is generated automatically using the settings you define on this screen. After you create the part, you must update the Donate button link so it directs users to the “[Personal Page Manager] PPM — Donate” page.
1. To allow online donations from personal pages, select **Support Online Donations**. Selecting this checkbox enables the options on this screen.

2. In the **Constituency** field, select the constituency to assign to new donors who are not already constituents in your database. Donors do not view this information. For more information about constituencies, see the **Program Basics Guide**.

3. In the **Minimum Gift Amount** field, enter the minimum donation a donor can contribute. Enter “0” or leave this field blank to allow donors to contribute any gift amount.

4. To allow donors to contribute a single gift and pay the total amount at the time of the donation, select **Allow one-time gifts** under **Donor Gift Scheduling Options**. A **One time gift** option appears under **Type of gift** on the donation form.

5. To allow donors to contribute regular recurring gifts, under **Donor Gift Scheduling Options**, select **Allow recurring gifts**. A **Recurring gift** option appears under **Type of gift** on the donation form. When a donor selects **Recurring gift**, **Frequency** options appear.

To allow the donor to determine the frequency of the recurring gift on the donation form, select **General**. Donors can select to make a contribution every week, month, quarter, or year.

**Tip:** If a constituent donates a recurring gift and selects a start date that is not today’s date, the transaction downloads to Blackbaud CRM. However, the transaction is not sent to your bank merchant when the donor submits the recurring gift. The merchant receives the transaction from the batch
output you send to your bank for processing from Blackbaud CRM. For more information about bank merchants, see the *Administration Guide*.

To define the recurring gift schedules donors can choose, select **Specific**.

a. Select “Weekly,” “Monthly,” “Quarterly,” or “Annually” as the frequency.
b. In the **On** field, select a day or date donors can choose to schedule the gift.
c. To add the frequency to the donation page, click **Add Frequency**.

**Note:** To add multiple frequency options to the donation form, enter each custom schedule and click **Add Frequency** to add the new schedule to the list. Each schedule you enter appears in the **Frequency** grid.

d. Select **Allow donor to enter ending date**, if donors can specify when the recurring gift ends.
e. In the **Minimum Installment Amount** field, enter the minimum amount a donor can select to pay for each installment. For example, if you enter “10,” in this field, when a donor selects a pledge installment schedule, each pledge payment must be at least ten dollars.

**Note:** You can enter a minimum installment amount to prevent donors from making small payments over a long period of time. For example, if you do not enter a minimum amount, a donor may pledge twenty dollars and choose to pay one dollar each month for twenty months.

6. Under **Donor Options**, select the options to make available to donors.

![Donor Options](image)

a. To allow a company to donate, select **Allow corporate gifts**. When you select this checkbox, **This donation is on behalf of a company** appears on the donation form.
b. To allow donors to give anonymously, select **Allow anonymous gifts**. When you select this, **I prefer to make this donation anonymously** appears on the donation form.
c. To allow donors to enter comments on the donation form, select **Allow comments**. Information entered in the **Comments** field on the donation form download to the Attributes tab on a gift record in Blackbaud CRM.
d. To allow donors to provide matching gift company information, select **Allow matching gifts**. When you select this checkbox, **My company will match my gift** appears on the donation form. Donors can select the checkbox and enter the company name in the **Company** field. If you use **MatchFinder Online**, **Look it up** appears next to the checkbox. Visitors click the link to access **MatchFinder Online**.
and search for the company. MatchFinder Online contains information about matching gift companies, such as the minimum and maximum gift details and match ratio.

**Note:** The program does not support matching gifts for recurring gifts.

7. To create a tribute section on the donation form, select **Allow tribute gifts**.

   ![Tribute Options](image)

   - **a.** To allow the donor to enter the tribute information, select **General**.
     Select the checkbox for each tribute type to include in the tribute section. The tribute types listed are entries from the Tribute Types table in Blackbaud CRM.

   - **b.** To apply all gifts to a specific tribute, select **Specific**.
     To select a tribute from Blackbaud CRM, click **Tribute**. A search screen appears so you can search for the tribute. When you return to the Design tab, the Tribute field displays the tribute text and tribute type for the selected tribute. If you select a tribute that does not have a tributee associated with it, you cannot hide the tribute description.

   - **c.** To remove the **Description** field from the tribute section on the web page, select **Hide tribute description field**.
     If you select **Hide tribute description**, in the Tribute Introductory Text field, you can enter the text to appear at the beginning of the Tribute section on your donation form, such as “This gift is made in honor of someone special.”

   - **d.** To improve data entry, select **Display tribute name fields as two fields (first/last name)**. When you select this checkbox, the Tribute section of the donation form displays **First name** and **Last name** fields, so donors can enter specific information.
Note: If you do not select Display tribute name fields as two fields (first/last name), the Full name field appears in the Tribute section of the donation form.

e. Select Display acknowledgee name fields as two fields (first/last name) to create separate name fields for the acknowledgee. When a donor selects Mail a letter on my behalf on the donation form, the First name and Last name fields appear, so the donor can enter a specific acknowledgee.

Note: If you do not select Display acknowledgee name fields as two fields (first/last name), the Full name field appears on the donation form when a donor selects Mail a letter on my behalf.

Note: When you include tribute information on your donor page, Mail a letter on my behalf automatically appears on the page. When a donor selects this checkbox, name and address fields appear for the donor to enter information for use in a tribute letter.

8. Under Designations, click Add designation to choose each designation donors can associate with gifts. A row appears in the grid.

   a. In the Designation field, click the binoculars to select a designation to appear on the website.
   
   b. Select the Default checkbox for the designation that gifts apply to when donors do not select designations.

   To provide multiple designations for users to select from, click Add designation and repeat these steps to create another entry. When you do this, the Support multiple designations checkbox appears.

   c. To allow users to donate to multiple designations, select Support multiple designations.

   When you select this checkbox, Add to Cart appears on the donation page. Similar to purchasing items from a store, users select the designations to donate to.

9. Under Impact statement, select a note type to merge in the confirmation screen or acknowledgement email that informs the donor their gift is relevant to the designation. The available note types integrate from the Documentation tab for a designation in Blackbaud CRM.

   To merge the note in the confirmation screen or acknowledgement email, select merge fields in the HTML
editor from the Impact Statement node. For more information about the HTML editor, see the Program Basics Guide.

10. In the Giving Levels frame, you can select suggested giving levels donors view on the personal page. Click Add Giving Level to add a giving level to the grid. In the Display Name column, enter a name for the giving level to appear on the personal page. In the Amount column, enter the suggested amount. If you select Allow Other amount, donors can enter an amount other than the suggested amounts.

11. To select a giving level for your donors, click Add Giving Level under Giving Levels.

When you include giving levels and select Support multiple designations, each donation made to a fund is considered for the giving level. For example, if a $500 donation is required for Gold status, and a donor donates $250 to the 2008 Annual Fund and $250 to the Building Equipment Fund, the donor does not receive Gold status. If the gift is one $500 donation to the 2008 Annual Fund, the donor receives the Gold giving level status.

   a. In the Display Name field, enter the name of the giving level as it will appear on the website.
   b. In the Amount field, enter the gift amount for the giving level. You can enter the start amount or both the start and end amounts.
   c. To include a blank Other field on the Donation page, select Allow other amount.

12. To select an appeal for the gift, click Add source under Sources. With this information, your organization can manage how donors learn about donating through the website.
Tip: When you select source information, a **How did you hear about our site** field appears on the donation page. In this field, users can select from the appeals you select in this step.

a. In the **Display name** field, enter the name of the appeal to appear on the website.

b. In the **Default** column, select the checkbox for the appeal to use when the user does not select an appeal.

c. To hide an appeal from the **How did you hear about our site** field, clear the checkbox for the appeal in the **Display** column.

When you do this, you can add source information to the end of a system generated URL in an email that navigates the recipient to your donation page. For example, create a link to your donation page in an email message. At the end of the system generated URL, add &source=camp. When the recipient clicks the link, the **How did you hear about our site** field does not appear on the page. The appeal stores automatically based on the source information in the URL.

**Warning:** To track source information this way, you must use a system generated URL. You cannot use unique URLs or friendly URLs created by a user.

The source information must include the appeal ID from Blackbaud CRM. For example, if the appeal ID in Blackbaud CRM is Annual2008, add &source=Annual2008 to the end of the system generated URL. If the appeal ID includes a space, replace the space with a %20. For example, if the appeal ID is CAMP LETTER add &source=CAMP%20LETTER.

If the **Display** checkbox is selected for the appeal and a user navigates to the donation page via a URL without source information, the **How did you hear about our site** field appears on the page.

d. To require users to select a source, select **Source is a required field**. If you select this checkbox, you must select the **Show In List** checkbox for at least one appeal.

To add additional appeals, click **Add source**. Another row appears in the grid for you to select another appeal.

e. Under **Required Fields**, select the checkbox for each donor field to make required on the donation form. To ensure you download the necessary constituent information into Blackbaud CRM, we recommend that you make all these fields required.
f. Under **Attributes**, select gift attributes to associate with the donation page.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Display</th>
<th>Required</th>
<th>Caption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auction ID</td>
<td></td>
<td></td>
<td>Auction ID</td>
</tr>
<tr>
<td>Item Number</td>
<td></td>
<td></td>
<td>Item Number</td>
</tr>
<tr>
<td>Sold On</td>
<td></td>
<td></td>
<td>Sold On</td>
</tr>
<tr>
<td>Declared Value</td>
<td></td>
<td></td>
<td>Declared Value</td>
</tr>
<tr>
<td>Named Giving Opp</td>
<td></td>
<td></td>
<td>Named Giving Opp</td>
</tr>
<tr>
<td>Donor Designation</td>
<td></td>
<td></td>
<td>Donor Designation</td>
</tr>
<tr>
<td>Check routing</td>
<td></td>
<td>✓</td>
<td>Check routing</td>
</tr>
<tr>
<td>Gift transfer date</td>
<td></td>
<td></td>
<td>Gift transfer date</td>
</tr>
<tr>
<td>Gift-in-Kind Type</td>
<td></td>
<td></td>
<td>Gift-in-Kind Type</td>
</tr>
<tr>
<td>Source</td>
<td></td>
<td></td>
<td>Source</td>
</tr>
<tr>
<td>Adopt An Animal</td>
<td></td>
<td></td>
<td>Adopt An Animal</td>
</tr>
</tbody>
</table>

**Tip:** The gift attributes that appear in this frame are created in Blackbaud CRM. After you process a donation transaction, the attributes you select appear on the Attributes tab of a revenue record.

**Tip:** The gift attributes that appear in this frame are created in **Administration** in the **Manage attribute categories** task. After you process a donation transaction, the attributes you select appear on the Attributes tab of a revenue record.

13. In the **Display** column, select the checkbox beside the gift attribute to associate with the part. To make the attributes required, select the checkbox in the **Required** column. To change the text of the attribute on the donation page, enter the text to display in the **Caption** field.

**Note:** If you know an attribute exists in Blackbaud CRM but do not see it, check the Settings tab in **Sites & settings** to make sure the attribute is available in Blackbaud Internet Solutions.
14. Under **Confirmation Screen**, select options for the donation summary that appears after a user submits a donation.

a. To use the program’s default confirmation screen, select **Use default confirmation screen**.

b. To customize a confirmation screen, select **Use custom confirmation screen**. The HTML editor appears. The program’s default confirmation screen appears in the HTML editor for you to customize according to your needs.

   In the box, edit the content to appear for the donation summary. To format the content’s appearance and layout, use the HTML editor toolbar. To include personalized information, use merge fields. For more information, see the *Program Basics Guide*.

   **Tip:** Customizations for the confirmation screen remain even if you select **Use default confirmation screen**. To remove your customizations for the screen, select **Use custom confirmation screen** and click **Load Confirmation Template**. The program’s default confirmation screen appears in the HTML editor for you to customize again.

15. In the **Merchant Account** field, select the merchant account to use to process credit card transactions received through the donation form, such as your organization’s IATS account. The system administrator sets up merchant accounts in *Administration*. For more information, see the *Administration Guide*.

16. Under **Payment Methods**, select the payment types donors can use to contribute to your organization.

17. To associate an eCard with the donation web page, select **Include eCards** under **eCard Options**. For more information about eCards, see the *Parts Guide*.

**Step 7: Configure Emails**

On this screen, you create email messages. You can use the default text provided or enter different text. For information about how to create an email, see the *Email Guide*.

1. Click **Welcome Email** to create an email to send to personal page owners who create pages.
2. Click **Forgotten Password/User ID Email** to create an email to send to page owners who forget their passwords or user ID.

3. Click **Donation Acknowledgement** to create an email to send to donors after they make a donation on a personal page. The Acknowledgement Email screen appears.

4. If **Include eCards** is selected on the Donation Form (Optional) screen, the **eCards Email** button appears for you to create and design an eCard for donations.

5. If receipt stack and number information exists for eReceipts on the Settings tab in **Sites & settings**, the **Configure eReceipts** button appears for you to create and design an eReceipt for donations. For more information, see Design eReceipts for a Personal Page Manager part on page 19.

   **Note:** When you create and save emails on this step, these email tasks appear as buttons on the action bar. To edit an email, click the button for that email.

6. Click **Save**. You return to **Parts**.

   ▶ **Design eReceipts for a Personal Page Manager part**

   After you create and design the eReceipt, a **Click here to view your eReceipt** link appears at the bottom of the donation confirmation screen. To view and print a pdf of the eReceipt, donors click this link.

   1. From the Parts screen, select the part for which you want to design an eReceipt.

   2. In the **Action** column, click **Click here to edit this part**. The Edit Part screen appears displaying the Design tab.

   3. Click **eReceipt**. The eReceipt design screen appears.

   **Note:** To create eReceipts, you must establish the receipt stack and number information in **Sites & settings**. For more information, see the **Administration Guide**.

   4. In the **eReceipt Options** frame, select whether to create an eReceipt for a **Credit card** or **Debit card**. You can create the eReceipt for both payment methods.

   5. To mark the gift as receipted when you download it to Blackbaud CRM, select the **Mark gift as receipted in Blackbaud CRM** checkbox.

      When you select this checkbox, the receipt number from Blackbaud Internet Solutions defaults in the **Receipt no.** field on the gift record in Blackbaud CRM. Also, the URL for a copy of the eReceipt pdf defaults as a gift attribute.
Warning: The program does not create a receipt number unless you include the eReceipt Number or eReceipt Download URL merge fields when you include eReceipt information in the acknowledgement.

6. In the eReceipt Content frame, enter the text to appear on the eReceipt. If you include the eReceipt Number field, the eReceipt contains the receipt number for the donation. To format the appearance and layout, use the HTML editor. For information about the HTML editor, see the Program Basics Guide.

7. To preview the eReceipt, click Preview PDF.
8. To save the eReceipt, click Save. You return to the Edit Part screen.
9. Click Save. You return to Parts.

Add Help Content for Personal Pages

On the Helplets tab, you can add custom text to help users understand how to use certain features in the Personal Page Manager part. For example, you can provide instructions for the Login screen or for the various Dashboard buttons.

To create help text, select the Helplets tab. In the Screen field, select a screen and enter your text in the box. For more information about the Helplets tab on the Edit Part screen, see the Parts Guide.